
Introduction
For information about a previous software version, refer to the document: Release Notes that
came with that software version.

New in Analyst 1.7.3 HotFix 3 Release Notes
Enhancements
HotFix 3 includes the enhancements that were included in the Analyst 1.7.3 HotFix 2 and
HotFix 1.

Analyst 1.7.3 HotFix 3 Enhancements

• Audit trail records can now be exported to PDF. To export the audit trail records, right-click
in the audit trail records pane. This feature lets users with read and write privileges, but no
delete privileges for a folder export the audit trail records. The exported file shows a different
display format than what is shown on the screen.

• A new Instrument Control Board (ICB) version 5 (ICB-5) is supported for SCIEX 3500, 4500,
5500, 5500+, 6500 and 6500+ systems.

• SCIEX 3500, 4500, 5500, 5500+, 6500 and 6500+ systems: A full configuration table header
is added to the File Info for a data file that is acquired with Analyst 1.7.3 HotFix 3 or later to
differentiate between ICB-4 and ICB-5.

• If an OptiFlow Turbo V ion source with the Nano probe is installed and Scheduled Ionization
is not selected in the acquisition method, then the IonSpray Voltage stays on between
sample runs. (AN-1721)

• The software supports the Operating systems Windows 10 version 21H2 and version 22H2.

• The software supports a newer version of the LC driver for the Shimadzu LC-40, Shimadzu
LC-20/30 configured with the Integrated System Shimadzu LC-20/30 Controller, and ExionLC
systems.

• The sMRM Calculator script has been updated.

Analyst 1.7.3 HotFix 2 Enhancements

Analyst 1.7.3 HotFix 2 includes the enhancements that were included in the Analyst 1.7.3
HotFix 1 as well as support for the VICI Valco valve 2-position 10-port: UMDA-C10W.
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Analyst 1.7.3 HotFix 1 Enhancements

• The option to use the deployment tool to do a new installation the Analyst software 1.7.3 with
the AAC security database is supported.

• Microsoft Office 2021 is supported. For a list of other supported versions of Microsoft Office,
refer to the software installation guide for the Analyst software 1.7.3.

• A new plate layout is available for Shimadzu LC-40 autosamplers.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported for Shimadzu LC-40
autosamplers. (AN-2758)

• A new plate layout is now available for Shimadzu SIL-30AC and SIL-30ACMP autosamplers
configured with the Integrated System Shimadzu LC Controller or the Integrated System
Shimadzu LC-20/30 Controller, with or without the RackChanger.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported. (AN-2223)

• The SIL-30ACMP autosampler can now be controlled using a Shimadzu LC-40 controller
(AN-2707, AN-3037)

• The Analyst Administrator Console (AAC) 3.1 client is installed with the installation of Analyst
1.7.3 HotFix 1. (AN-2836)

• The driver for the ExionLC 2.0 system is updated to version 1.0.0.91 (AN-2759)

• The firmware for the ExionLC 2.0 system has been updated. Contact sciex.com/request-
support to update the device firmware.

• Use firmware version 6.21 for ExionLC 2.0 column switching valves.

• Use firmware version 1.23 for ExionLC 2.0 autosamplers.

Fixed Issues
Images might not have been shown in large reports that were printed from the Analyst
Reporter

The computer performance and the available memory can have an effect on report generation.
On some computers, one or more images might not have been shown in large reports that
were printed from the Analyst Reporter. In the report, This image is not available was
shown as an alternative to an image of the correct chromatogram. Usually, this issue might have
occurred if a Results Table contained multiple data files. (AN-3460)

A memory leak might have caused a batch to stop if a system with a Shimadzu LC was
in operation for a long time while the StatusScope remote monitoring service was also in
operation
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If a system with a Shimadzu LC was in operation for a long time at the same time that the
StatusScope remote monitoring service was also in operation, then a memory leak might have
occurred and stopped the batch. The issue might occur with a Shimadzu LC-20/30 configured
through the Integrated System Shimadzu LC-20/30 Controller, Shimadzu LC-40, or ExionLC
system. (AN-3272)

A user who did not have delete permission for the API Instrument\Instrument
Optimization folder could not run Instrument Optimization.

A user could not run Instrument Optimization if the user did not have delete permission for
the D:\Analyst Data\Projects\API Instrument\Instrument Optimization folder.
(AN-593)

The Analyst software might have stopped working or changed the sample type of the
incorrect row if the Results Table had more than one analyte in Full Layout view, and
the user changed the Sample Type column, and then, without clicking anywhere else,
changed to another table layout.

If the user clicked on a different sample type in the Sample Type list while the Results Table
was in Full Layout view, and then immediately selected a different table layout that decreased
the total number of rows to be shown, the Analyst software might change the sample type of an
incorrect row or the software might stop working. (AN-2654)

If the last experiment was deleted, then the value of the parameter in the first experiment
in an acquisition method might have been changed

If a method had three or more experiments of the following scan types, whether the same kind
or mixed, and if the last experiment was deleted, then the precursor ions, such as product of for
Product (MS2) and EPI scan types, 1st precursor and 2nd precursor for the MS3 scan type,
Precursor Of for the Precursor Ion (Prec) scan type, or Loss of for the Neutral loss scan
type in the first experiment were replaced with the precursor ions from the deleted experiment,
regardless of whether the first and the deleted experiments had the same scan type. Other
parameters and the mass range remained for the original first experiment. The following scan
types were affected:

• EPI

• MS3

• Product (MS2)

• Precursor Ion (Prec)

• Neutral loss

(AN-2276)

The sort feature for a column in the sMRM Calculator script might not have worked
correctly if the number of digits before the decimal was not the same for all MRM
transitions
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If a method was opened in the sMRM Calculator script, then the option to sort the column in
increasing or decreasing order might not have worked correctly. If the number of digits before
the decimal for all MRM transitions in a column was the same (example: all RTs were above
1 but below 10 min), then there was no issue with the sort feature. There might have been an
issue if some RTs were below 10 minutes and some were above 10 minutes (example: RT=1.2,
2.5, 10.6). (AN-1353)

Scheduled MRM (sMRM) Pro algorithm: File Information showed 0.0 for those transitions
if, in the method, the MRM Window (sec) fields were left empty

When a Scheduled MRM (sMRM) Pro algorithm method was created, the user could type a
value for the MRM Window (sec) field to supersede the MRM detection window (sec) set in
the method. If the user left this field empty, then the transition used the MRM detection window
for acquisition, but the File Info showed 0.0 in the Window (sec) column for that transition.
(AN-270)

The Analyst Reporter might have created a Metric Plot that did not match the one shown
in the Analyst software

When the Analyst Reporter created a report that contained a Metric Plot that used sample
indices, then the plot looked different from the one shown in the Analyst software. In the report,
the sample indices of the data points incorrectly started at 0, whereas in the Analyst software,
the sample indices started at 1. (AN-1640)

If only some of the samples from a data file were included in the Results Table and if a
point was excluded from a Metric Plot, then incorrect information might have been shown
in the Details column in the Results Table audit trail records

If some samples from a data file were excluded from the Results Table, either because the
user did not add all of the samples from the data file to create the Results Table, or if the
user removed some samples from the Results Table after it was created, and if the user then
excluded one or more points from the Metric Plot that was created from that Results Table, then
an incorrect sample name and number might have been shown in the Details column in the
Results Table audit trail records. The issue only occurred if the point in Metric Plot that was
excluded was for a sample that was acquired after the samples were excluded from the Results
Table. (AN-1491)

If the Results Table contained multiple analytes, and if a user excluded or included a
point from a Metric Plot, then incorrect information was shown in the Details column in
the Results Table audit trail records

If a Results Table contained multiple analytes, then the exclusion or inclusion of an analyte point
for a sample caused an incorrect analyte name for that sample to be shown in the Details
column in the Results Table audit trail records. (AN-3369)

An incorrect UV picture tag was shown in the Analyst Reporter

The absorbance chromatograms in reports created by the Analyst Reporter might not have
matched those in the Peak Review pane in the Results Table. The negative Y-axis, if there was
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negative absorbance, was not shown in the report, and the Y-axis was always set from 0 mAU to
1000 mAU regardless of if the Y-axis min was set or not. (AN-2046)

More Analyst software warnings than were necessary were written in the application
event log

The following Analyst software warning was written over and over in the application event log:
The description for Event ID 3 from source Analyst cannot be found.
Either the component that raises this event is not installed on your
local computer or the installation is corrupted. You can install or
repair the component on the local computer. (AN-3196)

ADC data with an incorrect scale factor might be shown for configurations with an
integrated system and A/D converter.

If a configuration with an integrated system that was added before the A/D converter in the
hardware profile, such as MS + Shimadzu Integrated System + ADC, was used to acquire ADC
data, then a different scale factor than what was expected was shown in Explore mode. This
issue did not occur with hardware profiles where the integrated system was added last, such as
MS + ADC + Shimadzu Integrated System. (AN-3321)

The content in Weight/Volume column for a sample was not shown in File Info

If a batch that had values entered in the Weight/Volume column on the Quantitation tab of the
batch was submitted and acquired, then the Weight/Volume information was missing from the
File Info of the data files that were acquired. (AN-3126)

sMRM Calculator script fixes and improvements:

• As in the Analyst software, the sMRM Calculator script accepts decimal places in the
Window column. (AN-3364)

• All of the columns in the sMRM Calculator script can be sorted in alphanumeric order.
(AN-3353)

• Warning messages give better information when a user enters an invalid value or loads
a method that is not a Scheduled MRM (sMRM) algorithm method. (AN-3351, AN-3334,
AN-3310)

• The sMRM Calculator script supports Scheduled Ionization acquisition methods. (AN-3312)

• The sMRM Calculator script can open a Scheduled MRM (sMRM) algorithm method in Mixed
Mode. (AN-3311)

The transitions with Retention Time of 0 minutes were not shown correctly in the graphs
in the sMRM Calculator script

A transition with a Retention Time of 0 minutes in a Scheduled MRM (sMRM) algorithm
method was monitored throughout the run duration. However, in the sMRM Calculator script,
this transition was not fully shown in the Method Overview graph, and is not fully included for
counting or calculation throughout the run duration in the Concurrency and Cycle Time graphs.
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In addition, the MRM index on the Y-axis in the Method Overview was off by 1. Y-1 was shown
even though it was supposed to be the Y value.

Note: The algorithm for dwell time calculation is not changed from the one used in previous
versions. Refer to the section: Notes on Use.

(AN-1620)

Issues Fixed in HotFix 2 and Included in this HotFix

The Analyst software stopped working when users printed from the File > Print >
Workspace

If data, such as methods or Results Tables, was printed from the File > Print > Workspace,
then the Analyst software stopped working even though the data was printed successfully. There
is no issue if users print from the File > Print > Window or File > Print > Pane. (AN-2079)

The Quantitation Wizard added an incorrectly selected sample if one of the datafiles had a
checksum error

In Quantitation Wizard, if users clicked Add All Files to add multiple datafiles to the Selected
Samples list, and if one of the datafiles had a checksum error, then the datafile with a checksum
error was not added but the sample from the next datafile that had a valid checksum or had no
checksum was added twice. (AN-1653)

If data was being acquired with the Shimadzu or ExionLC PDA module in 2D mode with
the slow sampling rate, then data acquisition occasionally stopped at the end of the run
and did not move to the next sample

If an acquisition method that included a Shimadzu or ExionLC PDA module used the slow
sampling rate, such as 2000 ms in 2D mode, to acquire data, then acquisition might have
become stuck at the end of the run and did not move to the next sample in the batch. (AN-2980,
AN-2975)

Users assigned a non-administrator role that had Overwrite Acquisition method access
enabled but did not have delete rights enabled for the Analyst Data folder could not
overwrite methods in Tune and Calibrate mode

A user with a non-administrator role that had Overwrite Acquisition method access enabled
but did not have delete rights enabled for the Analyst Data folder could overwrite acquisition
methods in Acquisition mode but not in Tune and Calibrate mode. (AN-2732)

If an internal standard was defined in the second period, then it could not be selected for
use in the first period in the Analyst software 1.7.3 quantitation methods

If a user was making a quantitation method in the Analyst software 1.7.3 with or without HotFix 1
installed, then if the internal standard was defined in the second period, it could not be selected
for use in the first period. (AN-2979)
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Corrupted audit trail records might have been shown when special characters were used
in the Change Description

If special characters such as a carriage return or a new line were used in the Change
Description for an audited event, then corrupted audit trail records might have been shown.
(AN-2733)

The Analyst software audit trail records showed the full name of the user instead of the
display name

In the Analyst software versions 1.7.2 and 1.7.3 with or without HotFix 1 installed, the Full User
Name field in the audit trail records showed the full names of the users instead of the Display
Names that were stored in the Windows Server Active Directory. This behavior was different
from what was shown in versions before 1.7.2. After the fix, the Display Names are shown in
the Full User Name field in audit trail records. (AN-2447)

The File Info might show incorrect information for some Agilent pumps that were directly
controlled by the Analyst software

If Agilent 1260 pumps were directly controlled by the Analyst software and not controlled using
the Analyst Device Driver, then the values for the Max Pressure Ramp and Max Flow Ramp
reported in the File Info were interchanged. In addition, the Max Flow Ramp Up and Max Flow
Ramp Dn information was shown in the File Info for all Agilent pump models that were directly
controlled by the Analyst software even though they only applied to the Agilent 1290 G4220A
and Agilent 1290 G4220B pump models. (AN-2754)

A target project was not made if there was a double backslash in the middle of a network
path for the Project Source Directory and Project Destination directory

The Analyst software does not generate a double backslash (\\) in the middle of a network path
for a project. However, for some reason, if the user copied a project in the Analyst software, and
if a \\ was in the middle of a network path in both the Project Source Directory and Project
Destination directory fields, then the Analyst software was unable to make the target project.
The workaround was to replace the double backslash (\\) with a single backslash in the Project
Source Directory field. (AN-2568)

The toolbar in the Analyst software did not refresh correctly after the user clicked the
icon for the Administrator Console Connectivity Settings.

In Configure mode, after the user clicked the icon for the Administrator Console Connectivity
Settings in the toolbar, the right side of the toolbar, where there are no toolbar icons, could not
be seen.
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Figure 1 AAC Icon (Old)

This issue is fixed in this release. This HotFix introduces a new icon, shown in the following
figure, for the Administrator Console Connectivity Settings and a tooltip, AAC settings.

Figure 2 AAC icon (New)

(AN-1204)

Positive and negative spikes could have been shown in PDA data acquired in 2D mode

If PDA data was acquired in 2D mode with a Shimadzu SPD-20 or SPD-30 configured through
the Integrated System LC-20/30 Controller, or a Shimadzu SPD-40, or an ExionLC PDA, then
positive and negative spikes could have been shown if the acquisition method used a high
sampling rate and included more than one channel. (AN-3022)

A user could still use the Analyst software in Mixed Mode after the Analyst software had
been screen locked
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If a user logged on to the Analyst software workstation using a VPN, or disconnected from the
network when the Analyst software screen was locked, then an Unspecified error message
was shown. If the user waited for approximately 20 seconds, and then clicked OK in response to
the error message, then the unlock screen dialog was shown. However, the user still could use
the Analyst software while the unlock screen dialog was shown. (AN-3004)

Users might have not been able to edit or create report templates in Microsoft Office

On a workstation with Microsoft Office 2013, 2016, 2021 or Office 365 installed, and with
a very high level of security policy applied, users might have gotten a certificate error for
TemplateContentControlManager.vsto when they tried to open any reporter template for
the first time on the computer. As a result, this add-in required for editing templates could not be
installed because the file TemplateContentControlManager.vsto was not digitally signed.
After this HotFix is installed, users can install this add-in with Microsoft Office 2013, 2016, 2021
or Office 365. Users can also edit or make a report template in Microsoft Office 2013, 2016, and
2021. Depending on the version of Office 365, users might not be able to edit or make a report
template in Office 365. If this issue occurs, then contact sciex.com/request-support. For more
information, refer to the section: Notes on Use. (AN-3202)

The Analyst Reporter might have grouped some analytes incorrectly and might not show
data for some of the analytes

This issue occurred if analytes that belonged to different analyte groups had names that started
with the same characters and one of these analytes ended in 1. For example:

• Morphine 1

• Morphine 2

• Morphine Dihydro 1

• Morphine Dihydro 2

These analytes should be in two separate analyte groups, but the Analyst Reporter incorrectly
put all of the analytes in one group. In addition, some of the analytes were not printed in the
report. Instead, one of the analytes was reported multiple times to replace those that were not
reported.

After the fix is installed, if analytes are to be included in same analyte group, then the analyte
names must end with a space and then an integer, and the characters from the start of the
analyte name to immediately before the last space character must be the same. Analyte names
have always been case sensitive. Thus, Morphine 1 and Morphine 2 are in the same group,
and Morphine Dihydro 1 and Morphine Dihydro 2 are in the same group. However, analytes with
names such as QAXL 357 1 and QAXL 225 2 would not be in the same group. To put these
analytes in the same group, the user must rename the analytes. (AN-1645)

If a Reporter template was made with a newer version of Microsoft Word, then an extra
empty line might be printed for each analyte or sample
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SCIEX has tested versions of Microsoft Word from 2016 and 2021. If the For Each tag was
used in a Reporter template that was made with a newer version of Microsoft Word, then the
printed Results Table report might contain an extra empty line for each analyte or sample. If
the If condition was not met for some analytes or samples, then the report contained a large
blank space between analytes or samples, depending on how many samples or analytes did not
meet the condition. This issue occurred because newer versions of Microsoft Word introduced
a hidden empty line after the For Each tag. The empty line could not be removed when the
template was made because the line was hidden. (AN-3104)

The exported text file and PDF file for a Results Table showed an error if the Analyte
Slope Baseline column data started with a -7

If a value in the Analyte Slope Baseline column of a Results Table started with –7, for example
–7.0054e001, then the exported text file and PDF file of the Results Table showed #DIV/0!
for that value. (AN-3254)

Issues Fixed in HotFix 1 and Included in this HotFix

Shimadzu LC-40 systems: The Analyst software batch stopped intermittently if non-
default values for the autosampler rinse mode and rinse method were selected

If the Shimadzu LC-40 system was used with the Analyst software 1.7.3, then the batch might
stop if, in the LC method, non-default values were selected for the autosampler rinse mode
and rinse method. (AN-2901)

Batch submission failed when a specified rack was selected in the acquisition method for
Shimadzu 20/30 autosamplers that had a rackchanger configured for use

If a Shimadzu autosampler with a rackchanger that was configured for use through the
Integrated Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if
the Specify Rack option was selected in the acquisition method. (AN-1806)

Batch submission might have failed if a specified rack was selected in the acquisition
method for Shimadzu 20/30 autosamplers that did not have a rackchanger configured

If a Shimadzu autosampler that did not have a rackchanger configured through the Integrated
Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if the
Specify Rack option was selected and Rack 1.5 mL 105 vial or Rack 1.5 mL 70 vials was
used in the acquisition method. (AN-2805)

If the Analyst Classic quantitation algorithm was used to quantitate poorly separated
small peaks, then a smaller peak area than expected might be calculated when an
atypically large value for the Separation Height or Separation Width was used for
integration

If the Analyst Classic quantitation algorithm was used to calculate the area of a small peak that
is on the shoulder of a large peak that eluted before or after the small peak, then the automatic
integration that used an atypically large value for the Separation Height parameter, such as
0.6 (default is 0.01), or the Separation Width parameter, such as 4.0 (default is 0.2) could
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cause the peak area to be calculated with a lower value than if the peak area was integrated
manually.

This issue might only occur if peaks that are not well separated are integrated. The issue has
been fixed for any Results Table that is made using the Analyst 1.7.3 HotFix 1 or later. If a
Results Table was created using the Analyst software, version 1.7.3 or an earlier version, then
opening or editing the Results Table or updating other integration parameters in Analyst HotFix 1
or a later version will not cause the new peak area calculation. To update the calculation for an
analyte, in the Results Table, change the quantitation method by removing the analyte and then
adding the analyte back. Click Tools > Results Table > Modify Method. The peak area will be
calculated for the newly added analyte. (AN-2844)

In the Analyst Administrator Console (AAC) users could add projects from multiple
Project Roots but the Analyst software could only access projects from one Project Root

In the AAC, the Workgroup > Projects node let projects from multiple Project Roots be added.
However, in the Analyst software, only projects in the Project Root that was created first were
accessible by the user. In the Analyst 1.7.3 HotFix 1 and later versions, the user can access
projects from different Project Roots using the Root Selection dialog when the Analyst software
is opened. (AN-2565)

Opening the File Info pane when multiple data files were open in the Analyst software
Explore mode might slow system performance

If different data files were open in Explore mode, if each of the data files had File Info open, and
if the user clicked Show Next Sample, Show Previous Sample, or Go To Sample to move to
a different sample for one of the data file windows, then the system performance might be slow
when the File Info pane was updated. (AN-2843)

Deactivating a hardware profile that included the ExionLC 2.0 system might intermittently
fail

Intermittently, when a user tried to deactivate a hardware profile that included the ExionLC 2.0
system, the following error messages are shown: The remote procedure call failed or
The RPC server is unavailable. To resolve this issue, close and then open the Analyst
software. (AN-2766)

Analyst 1.7.3 Patch for Shimadzu LC30 & LC40 Plate Layout (AN-2771)

This patch is included in HotFix 1. The patch gives support for a new plate layout for
the Shimadzu SIL-30ACMP and Shimadzu SIL-30AC autosamplers configured through the
Integrated System Shimadzu LC Controller or the Integrated System Shimadzu LC-20/30
Controller, and for supported Shimadzu LC-40 autosamplers (AN-2223, AN-2758).

• 96 deep well plate layout with alphanumeric numbering starting from the bottom left of the
plate. The following Rack Codes are available in the Batch Editor:

• Shimadzu SIL-30ACMP and SIL-30AC: Alpha Deep Well MTP 96

• Shimadzu LC-40 autosamplers: Alpha DWP 96
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The following are applicable when the new plate is selected for the Shimadzu SIL-30ACMP and
Shimadzu SIL-30AC autosamplers, or for a supported Shimadzu LC-40 autosampler:

• The locations in the Batch Editor are assigned numeric values, arranged horizontally.

• The Batch Editor supports the "fill down" feature.

• The Batch Editor can export to txt and csv files.

• The Batch Editor can import from txt and csv files.

Notes on Use
• All associated Analyst software folders or files must be created or edited in the Analyst

software to maintain 21 CFR traceability. File and folder level permissions for users must be
set in accordance with the standard operating procedures of the laboratory.

• In Analyst 1.7.3 HotFix 3 and later versions, the Method Overview, Concurrency, Cycle Time
and Dwell Time graphs in the sMRM Calculator script is updated to show the behavior
during acquisition where transitions with a retention time of 0 minutes are collected for the
entire run duration. However, the dwell time calculation algorithm used in both the sMRM
Calculator script and Scheduled MRM acquisition in the Analyst software stays the same
as in earlier versions. That is, for dwell time calculation only, the transitions with a retention
time of 0 minutes are treated as transitions to be run from 0 minutes to 0 plus half of
the detection window time, and for any transitions scheduled to be run after that, those
transitions are not considered as concurrent transitions with the ones with RT=0. This is
by design. In addition, in Analyst 1.7.3 HotFix 3 and later versions, the transitions with a
retention time of 0 minutes are shown as RT=half of the run duration for methods without
Scheduled Ionization selected, or as RT=half of the (Stop Time - Start Time) for methods
with Scheduled Ionization selected, in the Dwell Time graph in the sMRM Calculator script
because these transitions are run throughout the run duration.

• In the Analyst software, when a Results Table is exported as a PDF file, any column with a
cell that contains more than 118 characters will not be exported. Make sure that each field in
the Results Table contains no more than 118 characters. (AN-3337)

• Because virtual machines can be complex, it is not possible to test or support every
configuration of virtual machines. Therefore, SCIEX limits support to physical, supported
computers.

• Possibly, for the same data set with the same integration parameters, the peak areas
quantitated using Analyst 1.7.3 HotFix 1 or later, might have a minor difference from those
quantitated using the Analyst software 1.7.3 or earlier versions, even if the integration
parameter values are typical and the peaks show good separation and are well integrated.
The minor difference, if any, is a result of the fix for issue AN-2844. (AN-3350)

• The GS2 parameter is not used for acquisition if the APCI probe is used.

If an APCI probe is used to acquire data, then the Ion Source Gas 2 (GS2) parameter is not
used, even though a value for Ion Source Gas 2 (GS2) is shown in the File Info for the data.
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If a user creates a method with a heated nebulizer (APCI) probe, then while the default value
of Ion Source Gas 2 (GS2) of 0 is used in the Parameter Settings, the Ion Source Gas 2
(GS2) parameter in the method is not available and a value of 0 is shown. The value of 0 is
shown in the File Info for data acquired with the method.

However, if the method used for acquisition with the APCI probe was created with a
TurboIonSpray (TIS) probe, or if the method was created with an APCI probe but the
Ion Source Gas 2 (GS2) had a non-zero value set in Parameter Settings, then the Ion
Source Gas 2 (GS2) value shown in File Info is the Ion Source Gas 2 (GS2) value set
in the TurboIonSpray (TIS) probe method or the Ion Source Gas 2 (GS2) value from the
Parameter Settings.

To prevent any issues, we recommend that methods be created after the hardware profile
with a heated nebulizer (APCI) probe is activated, and that the Ion Source Gas 2 (GS2) field
be set to 0 in Parameter Settings. The Ion Source Gas 2 (GS2) value in File Info would
always be 0. If a non-zero value is set in the Parameter Settings, then the Ion Source Gas
2 (GS2) field that is unavailable in the acquisition method would also have a non-zero value,
although this field is not used. (AN-3389)

• A change made manually to a cell in the Batch Editor takes effect only after the user
clicks outside of the cell that was changed

In a batch, after a change is made manually to a cell, such as to change to a different vial
position, the software does not update the value until the user clicks a different cell or tab, or
presses Enter on the keyboard. If a user makes a change to a cell, does not move the cursor,
and then saves the batch, then the change is not saved. (AN-3384)

• Avoid the use of illegal characters or names for the Analyst software file name and a
file path for an Analyst root directory.

The Analyst root directory path works the same as the path in the Windows operating system.
Do not use the following characters in the Analyst software file names and paths to the
Analyst root directory, as in the Windows operating system.

• # pound

• % percent

• & ampersand

• { left curly bracket

• } right curly bracket

• \ back slash

• < left angle bracket

• > right angle bracket

• * asterisk

• ? question mark
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• / forward slash

• blank spaces

• $ dollar sign

• ! exclamation point

• ' single quotes

• " double quotes

• : colon

• @ at sign

• + plus sign

• ` backtick

• | pipe

• = equal sign

• emojis

• alt codes

In addition to these characters, do not start or end the name of a file with a space, period,
hyphen, or underline.

File and folder name validations are done by the Windows operating system and not by
the Analyst software. Do not use the following file names that also cannot be used in the
Windows operating system:

CON, PRN, AUX, NUL, COM0, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8,
COM9, LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9. (AN-3273)

The Print Automatically function in Analyst Reporter does not print HTML reports

If Analyst Reporter is used to create reports and the output format Html is selected, then
do not select the Print Automatically check box. Although an HTML report can be created
successfully, the Print Automatically function does not operate because of limitations in the
Windows 10 operating system. To print documents automatically, select the Word or Pdf output
format. If the output format is PDF and Print Automatically is selected, then make sure that
Adobe Reader is set as the default program to open PDF files. (AN-3279)

File Info has been changed for the VICI Valco 2-position 10-port valve

For data files acquired in Analyst 1.7.3 HotFix 2 or later, the following updates have been made
to the information for the Valco valve in the File Info:

• ver has been changed to FW version, and the firmware version of the device is shown in the
FW version field. Previously, the ver field was empty and the firmware version was shown in
the S/N field.
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• N/A is shown in the S/N field, because the serial number is not available from the Valco valve
firmware. Make sure to record the device serial number from the hardware label. (AN-3220)

Workstation recommendations

If a customer-supplied computer is used with the system, then a best effort will be made to
support and troubleshoot any issues. However, in some cases, a standard SCIEX-supported
computer configuration will be required for further investigation.

Network Environment

The Analyst software supports the Windows-based LAN networks.

File Server

The Analyst software only supports Windows-based file servers. We recommend that the file
server be in the same building as the mass spectrometer. Contact Microsoft or the hardware and
software vendors for specification recommendations.

Note: Previously, Windows Server 2008 R2 and 2012 were specifically mentioned. During
testing we have found that compatibility is not version-dependent.

Microsoft Office compatibility

Microsoft Office 2013, 2016, or 2021 is required to make, open, or edit the report templates used
in the Reporter software. Microsoft Office 365 cannot be used to create, open, or edit report
templates that are used in the Reporter software. However, the Analyst software is compatible
with Microsoft Office 365 for all other functions. Microsoft Office 365 can be used to generate
a report in Instrument Optimization, and in Analyst Reporter with a report template that was
installed with the software, or with a report template that was created with Microsoft Office 2013,
2016, or 2021.

Shimadzu LC-40 PDA (SPD-M40) data might show small artificial regular spikes using
firmware version 2.00

If firmware version 2.00 is used for the Shimadzu SPD-M40 detector, then the data might show
small artificial regular spikes. The frequency of the spikes or valleys is related to the sample
speed of the PDA method. Make sure to use firmware (ROM) version 2.07 or later for the
Shimadzu SPD-M40 detector.

Different autosamplers permit different injection volume ranges and precisions

The injection volume controls the different precisions permitted for each autosampler. If an
invalid injection volume is entered, even if it is in the permitted injection volume range, then the
acquisition does not start as per the LC driver design. For example:

For the ExionLC AC autosampler, the injection volume setting range and permitted increment
and precision is shown in the following table:
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Table 1 ExionLC AC Autosampler Injection Volume Setting

Injection volume setting range 0.1 μL to 50 μL (standard), 0.1 μL to 100 μL (optional)

0.1 μL to 0.9 μL in 0.1 μL increments, 1 μL to 100 μL in
1 μL increments)

For the ExionLC AD autosampler, the injection volume setting range is shown in the following
table:

Table 2 ExionLC AD Autosampler Injection Volume Setting

Injection
volume setting
range

Total injection 0.1 μL to 50 μL

0.1 μL to 9.9 μL: 0.1 μL increments; 10 μL to 50 μL: 1 μL
increments

Loop injection Select either loop of 5 μL or 20 μL capacity.

0.1 μL to 9.9 μL: 0.1 μL increments; 10 μL to 20 μL: 1 μL
increments

For a Shimadzu autosampler, refer to documentation that came with the autosampler.

The minimum advanced permissions required by the Analyst software to store a result
file

For the minimum permissions required to store a result file, refer to the following figure.
(AN-1994)

Note: If the user of the Analyst software is in multiple domain user groups, then the folder
permission for the user is a cumulation of the permissions assigned to each of these groups.
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Figure 3 Permission Entry for Analyst Data Dialog

As of Analyst 1.7.3 HotFix 2, the grouping behavior for analytes in the Analyst Reporter
has changed

If analytes are to be included in same analyte group, then the analyte names must end with a
space and then an integer. Characters from the start of the analyte name to immediately before
the last space character must be the same. Analyte names have always been case sensitive.
Thus, Morphine 3 and Morphine 4 are put in the same group, and Morphine Dihydro 1 and
Morphine Dihydro 2 are put in the same group. However, analytes with names such as QAXL
357 1 and QAXL 225 2 would not be put in the same group. To put these analytes together, the
user must give the analytes a different name.

Before, analytes that belonged to different analyte groups, had names that started with the same
characters, and that one of these analytes ended in 1 were put in the same group. For example:

• Morphine 1

• Morphine 2

• Morphine Dihydro 1

• Morphine Dihydro 2

(AN-1645)
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Each time a hardware profile is activated, the time stamp of its hwpf file in Windows
Explorer changes.

By design, when a hardware profile is activated, the time stamp of its hwpf file changes. This is
because specific parameters must be read from the mass spectrometer and the hardware profile
manager to update the hwpf file during the activation process. (AN-1803)

Network acquisition: Special Acquisition Administrator Account

If the Special Acquisition Administrator Account is not used for network acquisition,
then the user logged on to the Analyst software must have Delete permission for the
WIFF_CACHE_BACKUP folder in the D:\Analyst Data folder. If the Special Acquisition
Administrator Account option is used, then the user logged on to the Analyst software does
not need access permission for the WIFF_CACHE_BACKUP folder in D:\Analyst Data folder.
However, the Special Acquisition Administrator Account must have, at a minimum, Modify
permission, with Delete permission, included for the WIFF_CACHE_BACKUP folder. For more
information about the Modify permission, refer to the following figure. (AN-1994)

Figure 4 Advanced Permissions

For more information about the Special Acquisition Administrator Account, refer to the
Analyst software 1.7.3 document: Laboratory Director Guide.

The ExionLC 2.0 software driver is not reverted to the version installed by the Analyst
software 1.7.3 after the Analyst 1.7.3 HotFix 1, 2, or 3 is removed

When the Analyst 1.7.3 HotFix 1, 2, or 3 is removed, the ExionLC 2.0 software driver version
1.0.0.91 stays. The driver is not reverted to version 1.0.0.83, which was installed with the
Analyst 1.7.3 software. If the ExionLC 2.0 system is to be used with the Analyst software
1.7.3, then remove the Analyst software 1.7.3 first, and then install the Analyst software 1.7.3.
(AN-2910)

Acquisition methods containing four pumps and created in a version earlier than the
Analyst 1.7 with HotFix 3 cannot be opened in newer versions of the Analyst software

If an acquisition method uses four pumps and is made in a version earlier than the Analyst
software 1.7 with HotFix 3, then this method cannot be opened in the Analyst software 1.7 with
HotFix 3 or in newer versions of the Analyst software. The method must be made again using
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the new hardware profile made in the Analyst software 1.7 with HotFix 3 or a later Analyst
software version. (AN-2818).

If pressure traces from Agilent or ADD are enabled, then they are shown under Show
Auxiliary Traces

In version 1.7.3, or later, of the Analyst software, the pressure traces from Agilent or ADD, if
enabled, are shown under Explore > Show > Show Auxiliary Traces.

Acquire each sample to a different data file if an ExionLC PDA or a Shimadzu PDA is used

We recommend that each sample be acquired to a separate data file if an ExionLC PDA or
a Shimadzu PDA is used. Doing so can prevent intermittent batch stoppages that are caused
when large amounts of data are written to a single file. (AN-1823, AN-2920, AN-2901)

Do a system check on Shimadzu and ExionLC PDAs to make sure the lamps are still in
good condition

A system check should be done on Shimadzu and ExionLC PDAs before data acquisition to
make sure that the lamps are still in good condition and do not cause poor data. This can be
done by directly connecting to Shimadzu modules using the Ethernet connection and entering
the IP address in a web browser, external to the Analyst software. Starting from Analyst 1.7.3
HotFix 3, batch acquisition will not stop when the system receives an error message from the LC
driver about the PDA detector lamp usage time. A warning that the PDA detector lamp usage
time cannot be updated will be logged in the system Event Viewer. (AN-3214)

The expected RT is not automatically updated when integration parameters are changed
during quantitation peak review in the Analyst software

From the Analyst software version 1.7 and later, the expected RT is not automatically updated
when integration parameters are changed during quantitation peak review in the Analyst
software. The expected RT entered or selected by the user is kept. (AN-861, AN-869)

The audit trail Full User Name column has changed

In the Analyst 1.7.1 Patch for RODC Network, the Analyst software 1.7.2, and the Analyst
software 1.7.3 with or without HotFix 1, the audit trail Full User Name column shows the Full
Name of the user account, as stored in the Windows Server Active Directory. The Display
Name and Full Name of the user account are typically the same, but they do not have to be.
The network administrator can make them different.

However, from Analyst 1.7.3 HotFix 2 and later, the audit trail Full User Name column shows
the Display Name of the user account, as saved in the Windows Server Active Directory, unless
the Display Name field is empty in the Active Directory, in which case the Full User Name is
shown.

Note: The e-mail address of the user (the logon name used for the Analyst software) will be
used in the Full User Name column if the Analyst software cannot get the full name or display
name of the user because there is no access to the network. (AN-2447)
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The toolbar in the Analyst software might not refresh correctly when scaling is changed

The toolbar might not refresh correctly under the following conditions:

• The user moved a remote desktop session window in which the Analyst software was open
from one monitor to another with a different monitor scaling setting, minimized the Analyst
window, and then maximized it.

• The user connected remotely to a workstation with the Analyst software installed from a
computer using a monitor with a different scaling setting from what was set on the workstation
monitor, logged on the Analyst software and left the software open, ended the remote
session, and then logged on directly to the workstation on which the Analyst software was left
open.

The right side of the software toolbar where there are no toolbar icons cannot be seen. If
users change between modes, then the toolbar icons from the previous mode might persist
in the user interface and cannot be clicked, and some icons on the toolbar look like they are
shown twice. The workaround is to close the Analyst software and then open it again. This
is a Microsoft behavior where some applications do not respond to scaling changes until the
applications are closed and then opened. To prevent the issue during a remote desktop session,
make sure that the Analyst software is closed before the remote desktop session is stopped,
and then start the next remote desktop session. Do not move the remote desktop session
between monitors with different scaling settings. Alternatively, use the same scaling setting on
all monitors connected to the computer used to connect remotely to the Analyst software. For
example, set all monitors to 125% scaling. To prevent any display issues, when logging on
directly to the Analyst workstation, make sure to close the Analyst software before stopping the
last remote session or use the same scaling setting on the Analyst workstation monitor and the
remote desktop monitor. (AN-3205)

National Instrument ADC card support

The older model of National Instrument ADC card (PCI-6032E) is not supported in Analyst 1.7.3
HotFix 2 or later versions.

Where to Get Help
• Analyst Software 1.7.3 Release Notes

• Analyst Software 1.7.3 Installation Guide

Known Issues and Limitations
Shimadzu LC-30 devices: An error might occur when the queue is restarted after samples
are aborted

If a Shimadzu LC-30 is configured with Integrated System Shimadzu LC-20/30 Controller, then
occasionally after the user aborts a sample run or stops the queue, and subsequently starts the
queue again, the next sample might show the acquisition error: Operation failed, device
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driver exception. To prevent the issue, deactivate and then activate the hardware profile
again after a sample is stopped or aborted. (AN-3092)

Users cannot enable or disable access to the Unlock/Logout Application feature for a role
in the Security Configuration dialog

On the Security Configuration dialog, access to the Unlock/Logout Application cannot be
directly enabled or disabled. As a workaround, to enable access to Unlock/Logout Application
for a role, enable the whole Analyst Application group if it was disabled, or disable and then
enable the access again for the whole Analyst Application group if it was enabled. Then disable
other individual items again in that group, as required. Similarly, to disable access to Unlock/
Logout Application for a role, disable the whole Analyst Application group if it was enabled,
or enable and then disable the access again for the whole Analyst Application group if it was
disabled. Then enable other individual items again in that group, as required. (AN-1646)

The IDA Method Wizard user interface for the triple quadrupole mass spectrometer might
be shown when a hardware profile that contains an Agilent 1260 DAD or 1290 DAD and a
QTRAP mass spectrometer is activated

For a hardware profile with an Agilent 1260 DAD or 1290 DAD added before a QTRAP mass
spectrometer, the IDA Method Wizard user interface for a triple quadrupole mass spectrometer
is shown, even though the activated mass spectrometer is a QTRAP mass spectrometer. The
issue only occurs if an Agilent 1260 DAD or 1290 DAD is added to the hardware profile before
the QTRAP instrument. The issue does not occur with hardware profiles that contain an Agilent
1100 or 1200 series of DAD, or hardware profiles that do not contain an Agilent DAD. (AN-140)

An incorrect response time might be used on Shimadzu SPD-40/40V UV detectors with
SCL-40/CBM-40/CBM-40 Lite ROM version earlier than 1.64.

If firmware versions earlier than 1.64 are used on a Shimadzu SCL-40, CBM-40, or CBM-40
Lite controller connected to a Shimadzu SPD-40/40V UV detector, then an incorrect interaction
between the Response mode and the Sampling time causes an incorrect response time. If the
response mode for the SPD-40/40V is set to Fast/Standard/Slow, then analysis is done with
response times of 0.5 s, 1.0 s and 2.0 s, respectively, regardless of the Sampling setting. There
is some influence on the data.

Workaround: Change the Response mode to Other, and then set the numeric value field to the
response time value or to a value that is less than the related sampling time. As an alternative,
use SCL-40/CBM-40/CBM-40 Lite firmware version 1.64 or later.

To print a pdf file from the Analyst software, the user must have Delete rights to the
folder where the pdf file is saved

In the Analyst software, if a file such as a Results Table, File Info, data list is printed to a pdf file
in a folder to which the user does not have Delete rights, then the user gets a message about
not having permission to modify files in the location. If this issue occurs, then do the following.

1. Click OK in the message.
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2. Save the file again using the same name.

3. Click Yes to replace the empty file that was created when the file was saved the first time.

This issue cannot be fixed because the function is in the Microsoft SDK and not in the Analyst
software. (AN-2756)

The VICI Valco 2-position 10-port valve shows an anomalous serial number and an empty
version in File Info in Analyst 1.7.3 HotFix 1 or an earlier version

The File Info of a data file acquired with a VICI Valco 2-position 10-port valve in Analyst 1.7.3
HotFix 1or earlier shows an empty FW version and an anomalous serial number. Record the
serial number from the hardware label, if required. (AN-3220)

For integrated Agilent LC devices, the LC run stops when the mass spectrometer stops
acquiring data, even if the LC run time is longer than the MS run duration

For Agilent devices that are directly controlled in the Analyst software and not through the
Analyst Device Driver (ADD), the LC run stops when the mass spectrometer stops acquiring
data, not at the pump stop time, even if the pump run time is longer than the MS duration. This
issue occurs with or without Scheduled Ionization enabled. Also, the Agilent pump trace, if
enabled, starts at the pre-rinse and not the injection time. Thus the trace is shown from 0 to MS
end time + approximately 0.5 min.

Workaround: configure the Agilent devices with the ADD software 1.4 if the LC run time is longer
than the MS run duration. (AN-2657)

Possible data loss and missing audit trail events after users log off from the Windows
operating system

In Integrated mode, if network acquisition is not set up to use the Special Acquisition
Administrator Account (SAAA), then the user who submitted the batch should not log off
from the Windows operating system until the batch acquisition is finished and the instrument has
gone to Standby. The Analyst software can stay closed.

In integrated mode, when SAAA is not used for network acquisition, with the instrument being
in Standby state, if the user submits batches, starts sample acquisition to the network, and then
logs off from Windows before the instrument goes to Standby, then samples appended to an
existing data file causes data to be lost for the samples that were already in the data file before
the samples were appended. The data loss and checksum error occurs when the data files are
synchronized with the ones on the network. Also, the project audit trail event for Sample: ‘x’
has been added to Data File ‘Y’ is not recorded for all samples acquired from the time that the
user logs off from Windows until the instrument goes to Standby. The issue affects the following
workflows:

• After a batch is submitted with samples to be acquired to different existing data files, or
multiple batches are submitted to be acquired to different existing data files, the user logs off
from Windows before the instrument goes to Standby. For any data file that has a different
file name from the one that was under acquisition immediately before the user logged off from
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Windows, and that has samples appended after the user logged off from Windows and before
the instrument went to Standby, the samples that were already in that data file before the
samples were appended are deleted.

• While the queue is in waiting or acquiring state, the user logs off from Windows and then any
user logs on to Windows and then the Analyst software, and then submits any batches to an
existing data file on the network. The samples that were already in the data file before the
new samples were appended are deleted.

• This issue does not occur in Mixed mode even if SAAA is not used, if the software was not
changed to Mixed mode while the system was still in waiting or acquiring mode. However, in
Mixed mode, for any batches submitted after the first user logs off from Windows and before
the instrument goes to Standby, after the batch acquisition is completed, the Analyst software
must be closed and started again for the data to synchronize to the network location.

To avoid the issues of data loss, checksum error, and missing project audit events, either use
SAAA or use Mixed mode. If neither SAAA nor Mixed mode can be used, then while samples
are waiting in the queue, do not log off from Windows until the system goes to Standby state.
(AN-3428)

Analyst 1.7.3 HotFix 3
Install the HotFix
Prerequisites

• The Analyst software 1.7.3 is installed.

1. Log on to the computer as a user with Administrator privileges.

2. Stop any acquisitions that are in progress, and then deactivate the hardware profile.

3. Close the Analyst software.

4. If the sMRM Calculator script is installed, then remove it. Refer to the section: (Optional)
Remove the sMRM Calculator Script.

5. Download Analyst 1.7.3 HotFix 3 from sciex.com/software-downloads.

Tip! To prevent installation issues, save the file to the local computer, in a location other
than the computer desktop. Then, before the start of the installation, disconnect any external
USB storage devices.

6. After the download is complete, right-click the Analyst1.7.3HF3.zip file.

7. Click Extract All, browse to and select the destination folder, and then click Extract.

8. Browse to and then double-click the setup.exe file.
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9. Obey the on-screen instructions to complete the installation.

10. Acquisition workstations with ICB-4: Go to the section: Update the Firmware and the
Configuration Table.

Note: Analyst 1.7.3 HotFix 3 includes all the changes made in Analyst 1.7.3 HotFix 1 and
Analyst 1.7.3 HotFix 2. Analyst 1.7.3 HotFix 1 or Analyst 1.7.3 HotFix 2 is automatically
removed when Analyst 1.7.3 HotFix 3 is installed.

11. (Optional) Install the sMRM Calculator script. Browse to C:\Program Files
(x86)\Analyst\Scripts\sMRM Calculator. For more information, refer to the
document: Scripts User Guide

12. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation for the Analyst software.

(Optional) Remove the sMRM Calculator Script
Note: If the Analyst software is upgraded to a later version, then the scripts that were previously
installed by users are not automatically upgraded. Remove the scripts that have been updated
and then install those updated scripts after the Analyst software has been upgraded. For more
information, refer to the document: Scripts User Guide.

1. Open Control Panel.

2. Click Programs and Features > Region and Language.

3. Select sMRM Calculator, and then click Uninstall.

4. Click Yes.
The selected script is removed.

Use a Deployment Tool to Install Analyst 1.7.3
HotFix 3
Use this procedure if the Analyst software 1.7.3 is installed and a deployment tool is used to
install the HotFix.

Use a Deployment Tool to Install the HotFix
Prerequisites

• The Analyst software 1.7.3 is installed.
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The Analyst 1.7.3 HotFix 3 can be installed with a deployment tool, such as Microsoft
Endpoint Configuration Manager (MECM), using either a Windows administrator account or a
non-administrator SYSTEM account.

Note: If a workstation must have the sMRM Calculator script installed, then remove the sMRM
Calculator script that was previously installed. Install the latest version of the sMRM Calculator
script after the Analyst MD software has been upgraded. Refer to the section: (Optional)
Remove the sMRM Calculator Script.

1. Use the deployment tool to make the AnalystTemp folder on the C:\ drive.
The software installation log file will be saved in this folder.

2. Run the following silent installation command from the installation files location:
setup.exe /s /v/qn /v”/l* “c:\AnalystTemp\analyst173HF3.txt”” /v/
norestart

3. Start the computers again on which the Analyst software was installed.

4. SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems:

a. Go to the section: Update the Firmware and the Configuration Table.

b. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation that comes with the Analyst software.

Systems that Use the AAC Security Database:
Use a Deployment Tool to do a Fresh Installation
of the Analyst Software 1.7.3
Use this procedure to install the Analyst software 1.7.3 if the Analyst software will use the AAC
security database.

Use a Deployment Tool to Install the Analyst Software 1.7.3
Note: This installation option was not supported in the Analyst software 1.7.3 release.

The Analyst software can be installed with a deployment tool, such as Microsoft Endpoint
Configuration Manager (MECM), using either a Windows administrator account or a non-
administrator SYSTEM account.

If the SYSTEM account is used, then the users on the workstations where the Analyst software
will be installed do not need to have administrator rights in Windows.

This procedure applies to new installations that use the Analyst Administrator Console (AAC)
security database.

1. Use the deployment tool to create the AnalystTemp folder on the C:\ drive.
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The software installation log file will be saved in this folder.

2. (Omit this step if only the AAC security database will be used to log on to the Analyst
software workstations, and if users will never change between the local security database
and the AAC security database to log on to the Analyst software workstations.) If the
SYSTEM account is used, then make the SDBInfo registry key and deploy it with the
deployment tool.

Note: The SDBInfo registry key is not required if a Windows administrator account is used
to deploy the software.

All Value Name entries must use the String Value type. At least one of User or Group
must be selected. Refer to the table: Table 3. For an example SBDInfo registry key, refer to
the following figure.

Figure 5 Example SBDInfo Registry Key

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SciexSccm\Analyst\SDBinfo
]
"UseMixedMode"="Yes"
"Domain"="DomainName"
"UserName"="First.Last"
"UserType"="Administrator"
"GroupName"="SharedAccounts"
"GroupType"="Operator"

Table 3 SBDInfo String Value Requirements

String Value Comment

Value Name Value Data (Example)

UseMixedMode Yes Yes: Mixed Mode will be
used in the Analyst software

No: Integrated Mode will be
used in the Analyst software

Note: This string value is
optional. If the string value
is not used, then Integrated
Mode will be used in the
Analyst software.
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Table 3 SBDInfo String Value Requirements (continued)

String Value Comment

Value Name Value Data (Example)

Domain DomainName The name of the domain to
which the user name and
group name belong. This
string value is required.

UserName FirstName.LastName The name of the domain
user who will log on to
Windows on the computers
where the Analyst software
will be installed.

UserType Administrator The Role type for the
user in the security
configuration for the Analyst
software. The default
roles include Administrator,
Analyst, Operator, End
User, QA Reviewer, and
Supervisor.

GroupName ShareAccounts The Group name on the
defined domain.

GroupType Operator The Role type for the
group in the security
configuration for the Analyst
software. The default
roles include Administrator,
Analyst, Operator, End
User, QA Reviewer, and
Supervisor.

3. To install the software, use the deployment tool to run the following silent install command
from the installation files location:
setup.exe /s /v/qn /v”/l* “c:\AnalystTemp\analyst.txt”” /v/norestart

4. Use the deployment tool to install the Analyst 1.7.3 HotFix 3. Refer to the section: Use a
Deployment Tool to Install the HotFix .

5. Add the AnalystAdminConsole registry key, and then deploy it with the deployment tool.

All Value Name entries must use the String Value type. Refer to the table: Table 4. For an
example AnalystAdminConsole registry key, refer to the following figure.
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Figure 6 Example AnalystAdminConsole Registry Key

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\PE
Sciex\Analyst\AnalystAdminConsole]
"Default Workgroup"="WorkgroupName"
"Server"="ServerName"
"Use Project Security"="Yes"
"Use Security Server"="Yes"

Table 4 AnalystAdminConsole String Value Requirments

Value Name Value Data (Example)

Default Workgroup WorkgroupName

Server ServerName

Use Project Security Yes

Use Security Server Yes

6. To connect to the AAC server 3.0, log on to the AAC 3.1 client as an AAC administrator from
any workstation where the Analyst 1.7.3 HotFix 3 has been installed.

Note: Before the AAC server 3.1 was available, the AAC administrator could not add a
workstation directly from the AAC server 3.0 computer.

7. Add the Analyst software workstations to the workstation pool for all of the workstations
where the Analyst software 1.7.3 has been newly installed and the AAC security database is
to be used.

8. Add the workstations to the workgroup defined for the Default Workgroup in the
AnalystAdminConsole registry key in step 5.

9. Before the Analyst software is opened, start the computers again on which the Analyst
software was installed.

10. SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems:

a. Go to the section: Update the Firmware and the Configuration Table.

b. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation that comes with the Analyst software.

Update the Firmware and the Configuration Table
Use the ConfigUpdater.exe program to update the system firmware to PIL2007 for the
SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems, unless the Analyst 1.7.3 HotFix 2
was installed before upgrading to Analyst 1.7.3 HotFix 3. Then use the ConfigUpdater.exe
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program to update the system configuration tables for the SCIEX 3500, 4500, 5500, 5500+,
6500, and 6500+ systems to the versions shown in the following table.

1. Browse to the Analyst\Firmware\ConfigUpdater folder, and then double-click
ConfigUpdater.exe. This folder is in C:\Program Files (x86)\.
The Configuration Table Update Program page opens.

Tip! The ConfigUpdater.exe program can also be started from the shortcut: Start >
SCIEX Analyst > ConfigUpdater

2. Select the Ethernet interface, and then click OK.

• For systems without Analyst 1.7.3 HotFix 2 installed before the software was upgraded to
Analyst 1.7.3 HotFix 3:

The ConfigUpdater utility opens and then identifies the new firmware version to be
installed.

Note: The ConfigUpdater utility will reset the mass spectrometer. This is normal and is
required by the update process.

• For systems that were upgraded from the Analyst 1.7.3 HotFix 2, the firmware should be
PIL2007. The following figure is shown.

Figure 7 Firmware/Configuration Table Update Program Dialog (Example)
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Go to step 6

3. Click Next.

Figure 8 Upload Confirmation Prompt

4. Click OK, and then wait until the message Uploaded firmware is ready is shown.

5. Click OK.
The Firmware/Configuration Table Update Program dialog with a list of supported
instruments opens.

6. Click Next.
A dialog with the new detected configuration table opens.

Note: If the utility provides more than one choice for the configuration file name, then select
the version shown in the following table.

Table 5 Supported Firmware and Configuration Table Versions for Systems with ICB-4

Mass
Spectrometer

Firmware Configuration Table Configuration
Table Version
File Info in the

Analyst
software

Configuration
Table Header
File Info in the
Analyst
software

SCIEX Triple
Quad 3500
system

PIL2007 FWTripleQuad3500R1
3.fw

13 TripleQuad350
0 231020 13
A1
D5086062D

SCIEX Triple
Quad 4500
system

FWTripleQuad4500R2
3.fw

23 TripleQuad450
0 231020 23
A1 D5115761F

QTRAP 4500
system

FWQTrap4500R22.fw 22 QTrap4500
231020 22 A1
D5134909C
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Table 5 Supported Firmware and Configuration Table Versions for Systems with ICB-4
(continued)

Mass
Spectrometer

Firmware Configuration Table Configuration
Table Version
File Info in the

Analyst
software

Configuration
Table Header
File Info in the
Analyst
software

SCIEX Triple
Quad 5500
system

FWTripleQuad5500R0
9.fw

09 TripleQuad550
0 231211 09
A2
D5024408G

QTRAP 5500
system

FWQTrap5500R08.fw 08 QTrap5500
231020 08 A2
D5024420F

SCIEX Triple
Quad 5500+
system

FWTripleQuad5500+R
03.fw

03 QET5500+
231020 03 A3
D5147809D

SCIEX Triple
Quad 6500
system

FWTripleQuad6500R0
6.fw

06 TripleQuad650
0 231020 06
A2
D5028416G

QTRAP 6500
system

FWQTrap6500R05.fw 05 QTrap6500
231020 05 A2
D5085559D

SCIEX Triple
Quad 6500+
system

FWTripleQuad6500+R
05.fw

05 TripleQuad650
0+ 231020 05
A2 D5094900F

QTRAP 6500+
system

FWQTrap6500+R04.fw 04 QTrap6500+
231020 04 A2
D5094902E

7. Click Next.
The following message is shown: Click OK to start the upload and do not
interrupt. The buttons will be disabled until upload finishes.

8. Click OK and then wait until the message: Uploaded Configuration Table is
ready is shown.

9. Click OK.
The configuration table update is complete and the ConfigUpdater confirms that the
configuration table is the current version.
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10. Click Finish to close the utility.

Systems with ICB-5: The following firmware and configuration tables are used. The use of
ConfigUpdater is not required.

Table 6 Supported Firmware and Configuration Table Versions for Systems with ICB-5

Mass
Spectrometer

Firmware Configuration Table Configuration
Table Version
File Info in the

Analyst
software

Configuration
Table Header
File Info in the
Analyst
software

SCIEX Triple
Quad 3500
system

QIL0101 FWTripleQuad3500R5
13.fw

13 TripleQuad350
0 231214 13
5A2
D5301595B

SCIEX Triple
Quad 4500
system

FWTripleQuad4500R5
23.fw

23 TripleQuad450
0 231214 23
5A2
D5199134B

QTRAP 4500
system

FWQTrap4500R522.fw 22 QTrap4500
231214 22 5A2
D5198720B

SCIEX Triple
Quad 5500
system

FWTripleQuad5500R5
09.fw

09 TripleQuad550
0 231214 09
5A2
D5199128B

QTRAP 5500
system

FWQTrap5500R508.fw 08 QTrap5500
231214 08 5A3
D5199124B

SCIEX Triple
Quad 5500+
system

FWTripleQuad5500+R
503.fw

03 QET5500+
231214 03 5A3
D5199121B

SCIEX Triple
Quad 6500
system

FWTripleQuad6500R5
06.fw

06 TripleQuad650
0 231214 06
5A1
D5305289B

QTRAP 6500
system

FWQTrap6500R505.fw 05 QTrap6500
231214 05 5A1
D5305287B
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Table 6 Supported Firmware and Configuration Table Versions for Systems with ICB-5
(continued)

Mass
Spectrometer

Firmware Configuration Table Configuration
Table Version
File Info in the

Analyst
software

Configuration
Table Header
File Info in the
Analyst
software

SCIEX Triple
Quad 6500+
system

FWTripleQuad6500+R
505.fw

05 TripleQuad650
0+ 231214 05
5A2
D5199130B

QTRAP 6500+
system

FWQTrap6500+R504.f
w

04 QTrap6500+
231214 04 5A2
D5197565B

Remove the HotFix
Note: Only a SCIEX field service employee (FSE) can remove the HotFix because the firmware
and configuration table must be downgraded when the software is removed. We do not
recommend that the HotFix be removed.

1. Deactivate the hardware profile and then close the Analyst software.

2. Use the ConfigUpdater utility to downgrade the configuration table to the version supported
by the Analyst software 1.7.3. For supported versions, refer to the document: Analyst
Software 1.7.3 Software Installation Guide. The ConfigUpdater utility is in the C:\Program
Files (x86)\Analyst\Firmware\ConfigUpdater.

3. Contact SCIEX service or support to downgrade the firmware.

4. Open the Programs and Features control panel.

5. Select Analyst 1.7.3 HotFix 3 from the list and then click Uninstall.
The HotFix is removed from the program list. The software is reverted to the Analyst
software 1.7.3. However, the driver for the ExionLC 2.0 system is not reverted to the
previous version.

Updated Files
The HotFix 3 makes the following changes to the Analyst, AB SCIEX, and Common Files
folders. The folders are in the C:\Program Files (x86)\ folder.

Analyst 1.7.3 HotFix 3 Release Notes

RUO-IDV-03-15924-A July 2024 33/45



Analyst\Bin (All files in this list, but one, are updated)

• AdminConsole.dll
• Analyst.exe
• Analyst.reg
• AnalystLauncher.exe
• AutosamplerDB.adb
• AutosamplerDB_SIL40_SIL30AC_SIL30ACM_AlphaDWP96.adb (Added unless HotFix 1

or HotFix 2 was installed)

• AuditTrailManagerCtrl.ocx
• AutosamplerDBServer.adb
• AutoTune-Instrument Tuning.exe
• BatchDir.dll
• BatchEditor.ocx
• CSISShimLC20LC30.dll
• CSISShimLC40.dll
• DataList.ocx
• DDISExion2LC.dll
• DDISSSciexLC.dll
• DDISShimadzu.dll
• DDMSMassSpec.dll
• DDVAValco.dll
• ExploreDataObjects.dll
• ExploreDir.dll
• HCE.dll
• HP1100lcMethodEditor.ocx
• LCPumpMethodSvr.dll
• MMSecurity.dll
• msmethodeditor.ocx
• MsmethodSvr.dll
• PD__scapSimulate.dll
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• PEIUtils.dll
• ProjectFront.dll
• QuantFullMethodEditor.ocx
• QuantIntegration.dll
• QuantMethod.dll
• QuantOptimizeWizard.dll
• QuantRT.ocx
• QuantWizard.dll
• QueueSvr.dll
• ReportEngine.ocx
• SciexLCMethodEditor.ocx
• SecurityConfigDir.dll
• StatusSvr.dll
• SyncMan.dll
• TuneDir.dll
• UserManager.dll

Analyst\BinEx (All files in this list are updated but for the ones added)

• MimicInstrumentHost.exe
• NexeraCL.chm (Added)

• Package_CBM20A.dll
• Package_CBM40.dll
• Package_ExionLC.dll
• Package_Jasper.dll
• Package_LC2030.dll
• Package_NexeraCL.dll (Added)

• SciChart.Charting.dll (Added)

• SciChart.Core.dll (Added)

• SciChart.Data.dll (Added)

• SciChart.Drawing.dll (Added)
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• Shimadzu.Chart.dll (Added)

• Shimadzu.LCDriver.CBM20A.Analog.dll
• Shimadzu.LCDriver.CBM20A.AutoConfiguration.dll
• Shimadzu.LCDriver.CBM20A.Autosampler.dll
• Shimadzu.LCDriver.CBM20A.CbmNet.dll
• Shimadzu.LCDriver.CBM20A.CommonData.dll
• Shimadzu.LCDriver.CBM20A.CommonUI.dll
• Shimadzu.LCDriver.CBM20A.FLD.dll
• Shimadzu.LCDriver.CBM20A.LCBase.dll
• Shimadzu.LCDriver.CBM20A.Oven.dll
• Shimadzu.LCDriver.CBM20A.PDA.dll
• Shimadzu.LCDriver.CBM20A.Pump.dll
• Shimadzu.LCDriver.CBM20A.RID.dll
• Shimadzu.LCDriver.CBM20A.Subcontroller.dll
• Shimadzu.LCDriver.CBM20A.SystemController.dll
• Shimadzu.LCDriver.CBM20A.UnifiedControl.dll
• Shimadzu.LCDriver.CBM20A.UnifiedStatus.dll
• Shimadzu.LCDriver.CBM20A.UVD.dll
• Shimadzu.LCDriver.CBM40.AutoConfiguration.dll
• Shimadzu.LCDriver.CBM40.Autosampler.dll
• Shimadzu.LCDriver.CBM40.CbmNet.dll
• Shimadzu.LCDriver.CBM40.CDD.dll
• Shimadzu.LCDriver.CBM40.CombinedConfiguration.dll
• Shimadzu.LCDriver.CBM40.CommonData.dll
• Shimadzu.LCDriver.CBM40.CommonUI.dll
• Shimadzu.LCDriver.CBM40.CRB.dll (Added)

• Shimadzu.LCDriver.CBM40.Oven.dll
• Shimadzu.LCDriver.CBM40.PDA.dll
• Shimadzu.LCDriver.CBM40.Pump.dll
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• Shimadzu.LCDriver.CBM40.SystemController.dll
• Shimadzu.LCDriver.CBM40.UnifiedControl.dll
• Shimadzu.LCDriver.CBM40.UnifiedStatus.dll
• Shimadzu.LCDriver.CBM40.UVD.dll
• Shimadzu.LCDriver.CBM40.Valve.dll
• Shimadzu.LCDriver.CBM40CL.AutoConfiguration.dll (Added)

• Shimadzu.LCDriver.CBM40CL.Autosampler.dll (Added)

• Shimadzu.LCDriver.CBM40CL.CombinedConfiguration.dll (Added)

• Shimadzu.LCDriver.CBM40CL.Oven.dll (Added)

• Shimadzu.LCDriver.CBM40CL.Pump.dll (Added)

• Shimadzu.LCDriver.CBM40CL.SystemController.dll (Added)

• Shimadzu.LCDriver.CBM40CL.UnifiedControl.dll (Added)

• Shimadzu.LCDriver.CBM40CL.UnifiedStatus.dll (Added)

• Shimadzu.LCDriver.CBM40CL.Valve.dll (Added)

• Shimadzu.LCDriver.CompactVirtualMode.dll
• Shimadzu.LCDriver.LC2030.AutoConfiguration.dll
• Shimadzu.LCDriver.LC2030.Autosampler.dll
• Shimadzu.LCDriver.LC2030.CbmNet.dll
• Shimadzu.LCDriver.LC2030.CombinedConfiguration.dll
• Shimadzu.LCDriver.LC2030.IntegratedBaseData.dll
• Shimadzu.LCDriver.LC2030.IntegratedBaseUI.dll
• Shimadzu.LCDriver.LC2030.Oven.dll
• Shimadzu.LCDriver.LC2030.PDA.dll
• Shimadzu.LCDriver.LC2030.Pump.dll
• Shimadzu.LCDriver.LC2030.SystemController.dll
• Shimadzu.LCDriver.LC2030.UnifiedControl.dll
• Shimadzu.LCDriver.LC2030.UnifiedStatus.dll
• Shimadzu.LCDriver.LC2030.UVD.dll
• Shimadzu.LCDriver.VirtualMode.dll
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• Shimadzu.LCDriver4.CbmNet.dll
• Shimadzu.LCDriver4.CommonData.dll
• Shimadzu.LCDriver4.DataHelper.dll
• Shimadzu.LCDriver4.LCBase.dll
• Shimadzu.LCDriver4.LCBaseUI.dll
• Shimadzu.LCDriver4.Logger.dll
• Shimadzu.LCMimic.Framework.dll
• Shimadzu.LCMimic.Interface.dll
• Shimadzu.LCMimic.Interop.Common.dll
• Shimadzu.LCMimic.Interop.Defines.dll
• Shimadzu.LCMimic.Interop.Interfaces.dll
• Shimadzu.LCMimic.Interop.LCMimic2Defines.dll
• Shimadzu.LCMimic.Interop.ShimLCConfig.dll
• Shimadzu.LCMimic.Interop.ShimLCControler.dll
• Shimadzu.LCMimic.Interop.ShimLCCore.dll
• Shimadzu.LCMimic.Interop.ShimLCMethod.dll
• Shimadzu.LCMimic.Interop.ShimLCSetup.dll
• Shimadzu.LCMimic.Interop.ShimLCStatus.dll
• Shimadzu.LCMimic.Package.dll
• Shimadzu.LCMimic.ServerCommon.dll
• Shimadzu.LCMimic.ServiceInterfaces.dll
• ShimLC2030.chm
• ShimNexera40.chm
• ShimNexeraLC.chm
• VDISSciexLC.exe
• _ReadMe.pdf
• _revisionInfo.txt

Analyst\BinEx2 (All files in this list are updated but for the ones added)

• ExionInterop.Common.dll

Analyst 1.7.3 HotFix 3 Release Notes

38/45 July 2024 RUO-IDV-03-15924-A



• ExionInterop.Interfaces.dll
• ExionInterop.LCController.dll
• ExionInterop.LCCore.dll
• ExionInterop.LCDefines.dll
• ExionInterop.LCSetup.dll
• ExionInterop.LCStatus.dll
• IntegratedLCSystemDriver.DriverCore.Base.dll
• IntegratedLCSystemDriver.DriverCore.ClientComponents.dll
• IntegratedLCSystemDriver.DriverCore.ServerComponents.dll
• LCMimicDemo.exe
• de-DE subfolder
• en-US subfolder

Analyst\Firmware (All files in this list, but one, are added)

• PIL2007 (Added unless HotFix 2 was installed)

• FWTripleQuad3500R13.fw
• FWTripleQuad4500R23.fw
• FWQTrap4500R22.fw
• FWTripleQuad5500R09.fw
• FWQTrap5500R08.fw
• FWTripleQuad5500+R03.fw
• FWTripleQuad6500R06.fw
• FWQTrap6500R05.fw
• FWTripleQuad6500+R05.fw
• FWQTrap6500+R04.fw
• QIL0101
• FWQTrap4500R522.fw
• FWQTrap5500R508.fw
• FWQTrap6500+R504.fw
• FWQTrap6500R505.fw
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• FWTripleQuad6500R506.fw
• FWTripleQuad3500R513.fw
• FWTripleQuad4500R523.fw
• FWTripleQuad5500+R503.fw
• FWTripleQuad5500R509.fw
• FWTripleQuad6500+R505.fw

Analyst\Firmware\ConfigUpdater (All files in this list are added unless HotFix 2 was
installed. All files are updated if HotFix 2 was installed.)

• AxInterop.ComctlLib.dll
• AxInterop.InetCtlsObjects.dll
• AxInterop.MSCommLib.dll
• AxInterop.MSFlexGridLib.dll
• AxInterop.MSWinsockLib.dll
• ConfigUpdater.exe
• ConfigUpdater.exe.config
• ConfigUpdater.pdb
• ConfigUpdater.xml
• Interop.ComctlLib.dll
• Interop.InetCtlsObjects.dll
• Interop.MSCommLib.dll
• Interop.MSFlexGridLib.dll
• Interop.MSWinsockLib.dll
• Interop.Scripting.dll
• UpdateConfig.ini

Common Files\SCIEX\LLDriver (All files in this list are updated unless HotFix 1 or
HotFix 2 was installed)

• AliasBase_icf.dll
• AliasDCP_icf.ocx
• AliasRes_icf.dll
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• ASBase_icf.dll
• ASBaseDCP_icf.dll
• ASCIIDevices_icf.dll
• CfgCntl.dll
• CfgCntlProxy.dll
• CfgCntlSrv.exe
• CT21OvenBase_icf.dll
• CT21OvenDCP_icf.ocx
• CT21OvenRes_icf.dll
• IdentifyLocal.dll
• IdentifySrv.exe
• IdentifySrvProxy.dll
• InstrCntlANASM22L_icf.dll
• InstrCntlANBase_icf.dll
• InstrCntlANP81L_icf.dll
• InstrCntlANV41S_icf.dll
• InstrCntlBase_icf.dll
• InstrCntlCT21_icf.dll
• InstrCntlMc_icf.dll
• InstrCntlP61L_icf.dll
• InstrCntlS2650_icf.dll
• InstrDADBase_icf.dll
• InstrDADDCPBase_icf.dll
• InstrDADRes_icf.dll
• InstrS2650DCP_icf.ocx
• KBase_icf.dll
• KBaseDCP_icf.dll
• KNGeneral_icf.dll
• KPumpBase_icf.dll
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• KPumpP61LDCP_icf.ocx
• KPumpP81LDCP_icf.ocx
• KPumpRes_icf.dll
• KWCUnits.dll
• LogConfig.exe
• McMonitor_icf.dll
• OEMFolderAccess.dll
• RCServer.dll
• SparkProtocol_icf.dll
• SType.prm
• SvalvesBase_icf.dll
• SvalvesDCP_icf.ocx
• SValvesRes_icf.dll
• SxASController.exe
• SxControllerBase.dll
• SxDADController.exe
• SxOvenController.exe
• SxPumpController.exe
• SxPumpPController.exe
• SxSVController.exe
• SxVIBase.dll
• SxVIInterfaces.dll
• SxWSController.exe
• Units.txt
• WashStationBase_icf.dll
• WashStationDCP_icf.ocx
• WashStationRes_icf.dll

Analyst\Simulation (All files are updated)

• FWTripleQuad4500.sim
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• FWQTrap4500.sim
• FWQTrap5500.sim
• FWQTrap6500_HM.sim
• FWQTrap6500_LM.sim
• FWQTrap6500+_HM.sim
• FWQTrap6500+_LM.sim
• FWTripleQuad3500.sim
• FWTripleQuad4500.sim
• FWTripleQuad5500.sim
• FWTripleQuad5500+.sim
• FWTripleQuad6500_HM.sim
• FWTripleQuad6500_LM.sim
• FWTripleQuad6500+_HM.sim
• FWTripleQuad6500+_LM.sim

Analyst\Help
• Analyst 1.7.3 HotFix 3 Release Notes.pdf (Added)

• Administrator_Console.chm (Updated unless HotFix 2 was installed)

Tip! A shortcut to the Release Notes can be found in this location: Start > SCIEX Analyst

Analyst\Scripts\sMRM Calculator (Updated)

• sMRM Calculator Setup.exe

AB SCIEX\AnalystReporter\bin (Updated)

• Sciex.Report.DataSource.Analyst.dll
• Sciex.Report.Engine.dll

C:\Program Files\AB
SCIEX\ReporterOfficeAddins\TemplateContentControlManager (Updated unless
HotFix 2 was installed)

• TemplateContentControlManager.dll.manifest
• TemplateContentControlManager.vsto
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Contact Us
Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

SCIEX Support
SCIEX and its representatives have a global staff of fully-trained service and technical
specialists. They can supply answers to questions about the system or any technical issues
that might occur. For more information, go to the SCIEX website at sciex.com or use one of the
following links to contact us.

• sciex.com/contact-us

• sciex.com/request-support

Cybersecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supersedes all previous versions of this document.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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This document is provided to customers who have purchased SCIEX equipment to use in the operation of
such SCIEX equipment. This document is copyright protected and any reproduction of this document or
any part of this document is strictly prohibited, except as SCIEX may authorize in writing.
Software that may be described in this document is furnished under a license agreement. It is against the
law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license
agreement. Furthermore, the license agreement may prohibit the software from being disassembled,
reverse engineered, or decompiled for any purpose. Warranties are as stated therein.
Portions of this document may make reference to other manufacturers and/or their products, which may
contain parts whose names are registered as trademarks and/or function as trademarks of their respective
owners. Any such use is intended only to designate such products as those manufacturers' products and
does not imply any right and/or license to use or permit others to use such manufacturers' and/or their
product names as trademarks.
SCIEX warranties are limited to those express warranties provided at the time of sale or license of its
products and are the sole and exclusive representations, warranties, and obligations of SCIEX. SCIEX
makes no other warranty of any kind whatsoever, expressed or implied, including without limitation,
warranties of merchantability or fitness for a particular purpose, whether arising from a statute or
otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed,
and assumes no responsibility or contingent liability, including indirect or consequential damages, for any
use by the purchaser or for any adverse circumstances arising therefrom.
(GEN-IDV-09-10816-E)

For Research Use Only. Not for use in Diagnostic Procedures.
Trademarks and/or registered trademarks mentioned herein, including associated logos, are the property
of AB Sciex Pte. Ltd., or their respective owners, in the United States and/or certain other countries (see
sciex.com/trademarks).
AB Sciex™ is being used under license.
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